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Blokkeer uw agenda:
TMC NEDERLAND FORUM
7 oktober 2010
Studio 4, Mediapark Hilversum

Keynote presentaties - workshops - productontwikkelingen
gebruikerservaringen - informatiemarkt

Binnenkort meer informatie op www.tmc-nederland.nl

THEMA:
Nieuwe media

• MicroStation • Rail
• ProjectWise • Flexiweb/GWS
• Geo • RoPlan
• 3D • MX
• Fiber
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Als kersvers bestuurslid van TMC Nederland is 

mij gevraagd een voorwoord te maken voor deze 

MicroVisie. “Daar ga ik eens heel goed over nadenken 

tijdens mijn vakantie”, had ik aan de redactie gemeld. 

Ik was het alweer bijna vergeten, maar ik werd 

eraan herinnerd toen ik mijn mail ff aan het syncen 

was. Dat kon op het vakantiepark op een gratis 

WiFi access point van het restaurant. Ik was zeker 

niet de enige. Het was een drukte van belang met 

‘junks’ met Smartphones, laptops en netbooks. 

Ik hield het na een kwartiertje wel voor gezien, maar 

het viel me op dat vooral jongeren toch wel een 

groot deel van de dag aan het mailen, twitteren of 

op facebook en hyves zaten. Het continu bereikbaar 

zijn en steeds alles willen volgen heeft een naam 

gekregen: infobesitas. Informatieovervloed als 

een nieuwe ‘ziekte’. Deze ‘ziekte’ leidt tot klachten 

als vermoeidheid, slaaptekort en het probleem 

dat jongeren continu hun aandacht moeten 

verdelen, wat ze uit hun concentratie haalt.

Nieuwe media, voor sommigen een zegen en voor 

anderen een last. Persoonlijk vind ik het vooral een 

zegen met ongekende mogelijkheden. Die moge-

lijkheden gaan we nader onderzoeken tijdens het 

komende TMC Forum. De TMC Forumdag wordt 

gehouden op het mediapark in Hilversum en het 

onderwerp is ‘nieuwe media’. Een onderwerp waar 

we zeker een interessant programma omheen kun-

nen bouwen. Dus blokkeer je agenda op 7 oktober 

2010 en kom naar Hilversum. Voor degenen met 

een Smartphone, gebruik onderstaande QR code;

d.de.rooy@tmc-nederland.nl
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TMC IN PROJECTGROEP NLCS
Namens TMC Nederland hebben Ton Zwinkels van gemeente 

Pijnacker-Nootdorp en Nico van Caspel van gemeente Hoorn plaats 

genomen in de projectgroep NLCS. In deze projectgroep wordt on-

dermeer de strategie bepaald. Het eerste resultaat van de TMC is 

dat er een eigen lijnstijlenbibliotheek voor MicroStation komt, die 

beter gebruik maakt van de mogelijkheden van MicroStation. Dit om 

te voorkomen dat MicroStation-gebruikers de NLCS als een terug-

gang in de tijd ervaren en niet volgens deze standaard gaan werken. 

Daarnaast zal de NLCS in de vergadering van de Bouw Informatie 

Raad (BIR) formeel worden gevalideerd. Een onafhankelijke com-

missie heeft positief advies hierover aan de BIR gegeven. Na dit 

heugelijke feit zullen drie grote opdrachtgevers (Gemeentewerken 

Rotterdam, Rijkswaterstaat Dienst Infrastructuur en Dienst vastgoed 

Defensie) het invoeringsbesluit ondertekenen. Hiermee verklaren ze 

voor nieuw werk zelf in hun bestekken op te nemen volgens de NLCS 

te gaan werken en dat ook van hun opdrachtgevers te verlangen. 

OVERNAME ROPLAN SOFTWARE DOOR CROTEC
Onlangs heeft Crotec RoPlan, de IMRO tekenmodule, van Bentley 

overgenomen. Bentley heeft ervoor gekozen om software dat specifiek 

is ontwikkeld voor een bepaald land, niet langer zelf meer te ontwik-

kelen, maar relaties aan te gaan met strategische partners die de lokale 

markt goed kennen. Eerder betrof dit ook RoBeheer, een applicatie 

waarmee gemeenten, provincies of stedenbouwkundige adviesbureaus 

de digitale planvoorraad vanaf initiatief tot publicatie kunnen bege-

leiden en te monitoren. Alhoewel dit product initieel bedacht was als 

Bentley applicatie, heeft uiteindelijk Crotec dit programma met groot 

succes ontwikkeld en op de markt gebracht. Crotec biedt RoBeheer 

aan binnen het RoTotaal concept. Bestaande SELECT-overeenkomsten 

met betrekking tot RoPlan worden door Bentley nagekomen tot het 

eind van de overeengekomen contractperiode. Daarna kunnen gebrui-

kers een onderhoudsovereenkomst direct met Crotec af te sluiten.

TMC FIBER FOCUSGROEP
TMC Nederland wordt uitgebreid met een Fiber Focusgroep. Tot de 

doelgroep behoren bedrijven en overheden die glasvezelnetwerken 

ontwerpen, bouwen en beheren, zoals telecomproviders, gemeenten en 

aannemers.  De focusgroep zal worden opgericht tijdens het TMC Fo-

rum op 7 oktober, waar de groep drie presentaties zal geven. Contact-

personen zijn Arjen de Leeuw van Bentley en Eltjo Zuidema van Nacap.

Kort nieuws

BESTUURSVERANDERING TMC

Dolf de Rooij van de gemeente 

Amstelveen is het TMC hoofdbe-

stuur komen versterken. Helaas 

heeft André Sluyter van Crotec 

afscheid moeten nemen door 

gewijzigde werkzaamheden. TMC 

Nederland is nog op zoek naar 

een geschikte vijfde bestuurslid. 

BE INSPIRED EVENT

Bentley organiseert 19 en 20 

oktober in het Okura Amsterdam 

de BE Inspired Infrastructure 

Best Practices and Awards Event. 

Uit heel de wereld geven geno-

mineerden voor de BE Inspired 

Awards presentaties over hun 

succesvolle projecten. Meer info: 

www.bentley.com/beinspired

GEO KENNISDAGEN BIJ 

IT-PRO PEOPLE

Nieuw bij IT-PRO people zijn de 

GEO ééndagscursussen, voor 

iedereen die met zowel GEO als 

gemeentelijke werkzaamheden in 

aanraking komt. Kennis wordt bij-

gespijkerd over onderwerpen als 

GEO binnen de gemeente, GIS-

implementatie, beheer, regelge-

ving en standaardisatie, distributie 

en integratie, raadplegen en ver-

der… nog veel meer. Meer infor-

matie en data: www.itpropeople.nl 
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Agenda

7 juli / 27 augustus Inloopmiddag 3D printen
www.cad2reality.nl

Kudelstaart (NH)

15-16 september Architect@Work
www.architectatwork.nl

Ahoy, Rotterdam

21 september 17e NedGraphics Dag
www.nedgraphics.nl

De Reehorst, Ede

7 oktober 2010 TMC Forum
www.tmc-nederland.nl

Mediapark, Hilversum 

14 oktober 2010 Nationale Staalbouwdag
www.bouwenmetstaal.nl

Evenementenhal, Gorinchem

19-20 oktober 2010 BE Inspired Bentley Event 
www.bentley.nl

Hotel Okura, Amsterdam

24 november 2010 TMC ProjectWise bijeenkomst
www.tmc-nederland.nl

Stadskantoor, Zwolle

24 november 2010 CADCAM + GEO Event
www.cmedia.nl

Expo, Houten

DE MEESTE DIEPGANG IN IT

Surf snel naar: 

www.ct.nl
(Lees de voorwaarden)

ONTVANG 3 
NUMMERS C’T
VOOR SLECHTS 

10 EURO!
Als ik het magazine niet meer wil 
ontvangen, meld ik dat schriftelijk 

uiterlijk 6 weken voor verzending van 
het laatste nummer. 

Indien ik niets doe, wordt mijn abon-
nement automatisch 

met een jaar verlengd. 
(10 nummers voor 51 euro).

ct_3voor10.indd   1 17-09-2009   11:49:58
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Praktische informatie tijdens BE Communities LIVE Conference

Van 17 tot en met 21 mei heeft 

Bentley voor het eerst de  

BE Communities LIVE Conference 

georganiseerd. Helemaal voor het 

eerst was het niet, want al sinds 

1996 organiseert Bentley jaarlijks 

een conferentie. De doelgroep 

en het concept wijzigt eens in de 

paar jaar, maar nu lag de na-

druk op de professional, die met 

Bentley software werkt. Niet ver 

van het Bentley hoofdkantoor 

in Exton waren we bijeen in het 

Pennsylvania Convention Center 

in Philadelpia. Bentley nodigde 

een afgevaardigde van TMC 

Nederland uit voor deze confe-

rentie, zodat de TMC leden op de 

hoogte gebracht kunnen worden 

van de laatste ontwikkelingen. 

In de periode 1998-2000 werd hier 
in Philadelphia ook al de Bentley 
conference gehouden, toen nog als 
BIUC (Bentley International User 
Conference). Een bijzonder groot 
verschil met deze eerdere bijeenkom-
sten was dat trouwens niet. De week 
bestaat zoals gebruikelijk uit enkele 
keynotes en enkele honderden tech-
nische presentaties en workshops. 
Schreven we enkele jaren geleden 
nog wat sceptisch over de rol van de 
eindgebruiker bij de conference, dit 
jaar hebben we als gebruikers van 
Bentley software weinig te klagen. 
De conferentie is gemaakt naar het 
model van de online Bentley Commu-
nities, waarbij gebruikers van Bentley 
software ervaringen kunnen uitwisselen 
en van elkaar kunnen leren. Nu met de 
toevoeging van face-to-face contact.
Dit jaar geen groot nieuws zoals in 
het verleden met aankondigingen 
als Viecon, ProjectBank en andere 

zaken die soms niet (in die vorm) 
van de grond zijn gekomen. Daar-
entegen tal van kleine wijzigingen 
en updates die het leven van tech-
nici, die gebruik maken van Bentley 
software, zullen veraangenamen.

Om alle sessies hier te gaan beschrij-
ven gaat te ver. Het programmaboekje 
met daarin een korte vermelding van 
alle sessies bevatte al negenenzestig 
pagina’s! Daarom beperken we ons hier 
tot de hoofdlijnen van deze conferentie: 
V8i SELECTseries 1 en 2, Point 
Clouds, i-models en enkele andere 
noemenswaardige zaken. Aangezien 
Johan Vreede (voorzitter van de 
ProjectWise Focusgroep) verderop in 
deze MicroVisie ingaat op Project-
Wise wordt daar nu niet op ingegaan.

V8i SELECTseries 1 en 2

In oktober 2009 heeft Bentley de  
SELECTseries 1 versie van haar V8i 
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Praktische informatie tijdens BE Communities LIVE Conference
Tekst:  Gerrit Jan Werler, Witteveen+Bos

software bekend gemaakt. De volgende 
release, met de niet verrassende naam 
V8i SELECTseries 2, komt er ook al 
aan. Een aantal opmerkelijke verschil-
len met de standaard V8 versie zijn: 
•  Een aantal Luxology verbeteringen, 

zoals verbeterde animatietools, 
usebility enhancements (met name 
een gewijzigde interface) en snelheid 
(fast preview). Met SS2 komen daar 
nog een aantal civil tools bij.

•  Ondersteuning van Point Clouds in 
MicroStation zonder extra software.

•  Clash detection in MicroStation 
(direct tijdens het ontwerp en niet 
achteraf).

• 3D printing support
• Revit ondersteuning
•  Generative components is nu onder-

deel van standaard MicroStation.
•  RealDWG support (AutoDesk 

libraries)
•  DWG support t/m AutoCAD 2009. 

(Voor support van DWG 2010 kan 
een patch gedownload worden van 
de Bentley site en de installatie ervan 
is erg simpel. Om Civil 3D-objecten 
te kunnen tonen, moet de object 
enabler van de Autodesk site worden 
gedownload en geïnstalleerd)

•  Het werken met verschillende coördi-
naatsystemen is enorm verbeterd en 
vereenvoudigd.

•  De interface is veel intuïtiever – meer 
drag & drop. Om bijvoorbeeld een 
saved view als reference file te kop-
pelen kan naast de traditionele manier 
nu ook de saved view dialog geopend 
worden en kan de saved view op 
bijvoorbeeld een sheetmodel gesleept 
worden, waarna hij als reference 
gekoppeld wordt. 

•  Google Sketchup-achtige tekenmoge-
lijkheden (push and pull modeling).

•  ProjectWise dependency viewer, 
een tool om afhankelijkheden tussen 
tekeningen grafisch weer te geven.

• Dynamic Views in MicroStation

Ook nu heeft Bentley al deze func-
tionaliteiten toegevoegd zonder het 
fileformaat te wijzigen. En dat is best 
opmerkelijk, als je bedenkt dat de 
grootste concurrent van Bentley ieder 
jaar met een nieuw fileformaat op de 
proppen komt met alle vervelende ge-
volgen van dien. Om optimaal gebruik 
te kunnen maken van al deze nieuwe 
features is het wel aan te bevelen een 
update training te volgen of de TMC 
Tips en Trucs sessies te volgen.

Virtualisatie

In de eerste MicroVisie van 2009 
(jaargang 11 nummer 1) maakten 
we nog melding van het feit dat het 
gebruik van hardware virtualisatie in 
strijd was met het SELECTcontract. 
Bentley heeft nu anders besloten en 
ondersteunt de meest gebruikte virtu-
alisatieplatforms; VMWare en Citrix.

Point Clouds

Point clouds (‘punten wolken’) zijn 
het resultaat van een 3D laserscan. Een 
gebied, ruimte of object wordt hierbij 
door een laser afgetast en de punten 
waar de laser het object raakt worden 
met een kleine interval (bijvoorbeeld 
1mm) opgeslagen. Door de laserscan-
ner te combineren met een digitale 
fotocamera is bovendien van iedere 
pixel de kleur te bepalen, waardoor 
een volledig 3D-kleurenbeeld ontstaat. 
Niet in de vorm van vlakken, lijnen en 
krommingen, maar als een verzameling 
van punten, de point cloud. Het grote 
voordeel van laserscannen boven het 
inmeten is dat dit veel nauwkeuriger 
kan. Meer details worden waargenomen 
en objecten kunnen in kaart worden 
gebracht, die anders zeer lastig ingeme-
ten konden worden. Denk daarbij aan 
een druk bereden viaduct. Als je deze 
nauwkeurig wilt inmeten zal het verkeer 
stilgelegd moeten worden. Met 3D 
laserscanning is dit niet nodig. Terwijl 
het verkeer voortraast, wordt het viaduct 
nauwkeurig door de laser ingemeten.

MicroStation kan nu standaard met 3D 
point clouds werken zonder aanvul-
lende software. Bentley heeft hiervoor 
de Vortex engine van PointTools in 
licentie genomen en geïntegreerd in 
haar producten. Daardoor komt de point 
clouds-functionaliteit beschikbaar voor 
tal van Bentley applicaties, bijvoorbeeld 
MicroStation, PowerDraft, Bentley 
View, ProjectWise Navigator, PowerCi-
vil en PowerSurvey. Met point clouds 
is het eenvoudig om een bestaande 
situatie te vergelijken met een nieuw 
ontwerp. ‘Past het? Zijn de aansluitin-
gen correct? Treden er conflicten op..?’ 
Veel point cloud-formaten worden  

Keith Bentley
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ondersteund waaronder: XYZ, LAS, PTX, PGZ, ASCII en 
formaten van verschillende leveranciers. Het openen van 
een point cloud in MicroStation is niet moeilijker dan het 
openen van een reference file. Om point clouds te kunnen 
manipuleren is nog speciale software nodig, zoals bijvoor-
beeld Edit, Model en 4 Rhino van de firma PointTools.

i-model

Nieuw op de conference was de 
i-model, een container om infra-
structuurdata uit te wisselen in 
twee richtingen. Een i-model bevat 
het ontwerp, alle benodigde refe-
rence files en data om het volledige 
ontwerp te kunnen visualiseren. 

De data in een i-model is gecompri-
meerd, waardoor een i-model compact 

is. Een i-model is platformonafhankelijk.
Door gebruik te maken van een i-model 

kan met verschillende applicaties (bijvoorbeeld 
ProjectWise, Webbrowser of de Windows verkenner) 
een model worden bekeken. Daarmee wordt het moge-
lijk om in ProjectWise een model, in zowel 2D als 3D, te 
bekijken. Ook kan vanuit de webbrowser redline infor-
matie aan een model worden toegevoegd, zonder instal-
latie van software op de pc. Dezelfde functies komen ook 
beschikbaar voor de Windows verkenner en Outlook. 
Gebruikers van Firefox of Chrome hebben pech, aange-
zien Bentley een ActiveX component hiervoor wil ge-
bruiken. Een gemiste kans, zeker als je beseft dat IE op 
de mobiele markt geen rol van betekenis speelt. Het zou 
mij persoonlijk dan ook niets verbazen dat er iemand in 
Exton wakker wordt en dat dit concept wordt herzien.

Text Fields

Text Fields is een nieuwe zeer krachtige basisfunctie in 
MicroStation. Text Fields zijn dynamische teksten, die 

zich automatisch kunnen aanpassen. Denk daarbij 
bijvoorbeeld aan ruitkruisjes, die automatisch de 

coördinaten weergeven waarop ze getekend 
zijn. Of de aanduiding van de oppervlakte 

van een kamer, die automatisch wijzigt 
als de kamer qua grootte verandert. 

Het uitleggen van de mogelijkhe-

den van Text Fields kan eigenlijk het beste aan de hand van 
een hands-on voorbeeld. Dus probeer het volgende eens: 
Teken in MicroStation een rechthoek. Open de Text Editor 
en type ‘Oppervlakte=’ en klik vervolgens met de rech-
termuistoets in de tekst editor. Selecteer ‘Insert Field’ > 
‘Element Properties’ en klik op de getekende rechthoek. 
Selecteer onder Geometry de oppervlakte (Area). Klik op 
OK en plaats de tekst in de rechthoek. Er staat nu bijvoor-
beeld: Oppervlakte=10.3m2. Verander nu de oppervlakte 
van de rechthoek en de tekst past zichzelf automatisch aan.

3D hardware

In de paragraaf ‘V8i SELECTseries 1 en 2’ zijn de soft-
wareverbeteringen ten aanzien van 3D al kort genoemd. 
Dit jaar was er ook 3D hardwarenieuws. Sponsor Z Cor-
poration heeft nu bijvoorbeeld een 3D printer, die hoge 
resolutie plastic prototypes kan printen door met een 
laser in een vloeibaar polymeer te schijnen. Zo wordt 
een 3D-model omgetoverd naar een echt 3D-object. Ook 
waren de eerste 3D-beeldschermen te zien, die in combi-
natie met een 3D-bril een fantastisch 3D-effect geven.

MicroStation Print organiser

Wie nog gebruik maakt van Batchplot om tekeningen 
te plotten, moet zeker eens gaan kijken naar te Micro-
Station print organizer. Het is een tool voor het ma-
ken, beheren en publiceren van afdrukken. Het wordt 
door Bentley gezien als de vervanger van Batchplot, 
dat daarom ook niet meer verder ontwikkeld wordt.

Integrated Structural Modeling (ISM)

Met ISM is het mogelijk om meerdere varianten van een 
model automatisch door een computer (grid netwerk) door 
te laten rekenen, waarbij met vooraf ingegeven parameters 
wordt gevarieerd en waarbij automatisch de meeste kostef-
ficiënte oplossing wordt berekend. Zo zou je bijvoorbeeld 
voor een dakconstructie kunnen kiezen uit veel dunne of 
een paar dikke balken. De computer kan hiermee automa-
tisch variëren om de optimale oplossingen te berekenen 
(binnen de grenzen die de gebruiker zelf definieert).

Overnames

Bijna ieder jaar kondigt Bentley weer een aantal overna-
mes aan. Ondanks de recessie heeft Bentley ook afgelopen 
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•	 Training	Bentley	software	

•	 Altijd op maat 

•	 Optimale trainingsduur 

•	 Kostenefficiënt

•	 Nederlandstalige	support
•	 Ondersteuning	bij	implementatie/upgrade

T 0297-368 516  |  info@cad2reality.nl  |  www.cad2reality.nl 

jaar (2009) een aantal bedrijven overgenomen. KSJ Beijing 
Sofware Technology (met het product BridgeMaster dat met 
name in de Chinese markt gebruikt wordt voor een snelle en 
geautomatiseerde productie van brugconstructie-ontwerpen). 
9SQ dat Plant-software maakt voor de Koreaanse markt, 
gINT Software (dat zich bezig houdt met ondergrondse 
geo-informatie) en de bedrijven Enterprise Informatics en 
Exor. Met de overname van de laatste twee richt Bentley 
zich op het beheer van ‘assets’ tijdens de operationele fase 
met AssetWise. Daarbij neemt ProjectWise het beheer 
voor haar rekening tijdens het ontwerp en de bouw, en 
sluit AssetWise daarbij aan voor operationele periode.
 
Be Connected

De Be Connected online seminars zijn in de zomer van 2009 
geïntroduceerd en geven de gebruiker van Bentley software 
de mogelijkheid om gratis kennis op te doen van producten, 
middels ‘best practices’ en productseminars. En aangezien 

alles direct online beschikbaar is, is hiervoor geen reistijd 
nodig en kan het op elk gewenst moment gevolgd worden. 
Kijk voor meer informatie op www.bentley.com/beconnected.

Zoals gezegd zijn genoemde onderwerpen slechts een 
greep uit het vele informatie, die te verkrijgen was in het 
Pennsylvania Convention Center. Via onze Focusgroep-
bijeenkomsten proberen we zoveel mogelijk van het 
nieuws in uw vakgebied over te brengen. En is dat niet 
voldoende, overweeg dan om zelf volgend jaar ook aanwe-
zig te zijn op de BE Communities LIVE Conference! 

De BE Connected online seminars zijn direct 
online beschikbaar en kunnen op elk moment 
gevolgd worden. 

gaat verder als:

NIEUW:
•	 3D-modelleren
•	 Visualisaties	en	animaties
•	 3D-printen

De	onafhankelijke	Bentley	specialist	TriCentric	
gaat	verder	als	cad2reality.	Dit	betekent:

KOM	KENNISMAKEN	
OP	ÉÉN	VAN	DE	

INLOOPMIDDAGEN:
7 JULI

27 AUGUSTUS
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Mesh modeling commando’s in de praktijk
Bij civieltechnische werken is het 

vaak noodzakelijk om het grond-

verzet te bepalen. Via deze volu-

meberekening weet de civieltech-

nisch ontwerper hoeveel grond er 

verzet moet worden. Dit volume is 

weer van belang voor de prijsbe-

paling van de aannemer. Meestal 

worden deze berekeningen door 

de civieltechnisch ontwerper met 

de hand uitgerekend, wat een 

tijdrovend karwei is. Het is echter 

ook mogelijk om deze volume-

berekening door MicroStation uit 

te laten rekenen. Dit kan via een 

uitgebreide reeks van Mesh Mo-

deling commando’s, die MicroSta-

tion standaard aan boord heeft. 

De Mesh Modeling commando’s zijn 
in de MicroStation versie V8i ver-
der uitgebreid. De enige voorwaarde 
voor een volumeberekening is dat 
er een hoogtemeting (AHN) gedaan 
is van het betreffende gebied. Het 
Actueel Hoogtebestand Nederland is 
een bestand met voor heel Nederland 
gedetailleerde en precieze hoogtegege-
vens. Het eindresultaat zijn tekstbestan-
den met XYZ-waarden. Aan de hand 
van onderstaand stappenplan wordt 
duidelijk hoe dit in zijn werk gaat. 

Hoogtebestanden importeren

Importeer de hoogte bestan-
den van het betreffende gebied 
via Tools > Dimensions > XYZ 
Text > Import Coordinates. 

Zorg ervoor dat binnen het dialoog-
venster Import Coordinates de optie 
Import op Point Element staat. Het 
commando zorgt ervoor dat op ieder 
XYZ-coördinaat een punt gezet wordt 
met als resultaat een puntenwolk, 
van in ons geval 500m bij 250m.

Teken het gebied waar het grondverzet 
berekend moet worden en zorg ervoor 
dat dit een gesloten element is (shape, 
complex shape). De punten buiten 
het gebied dienen eerst verwijderd te 
worden. Maar let op! Het gebied wordt 
een Fence en wordt door de Void Clip 
actie verwijderd. Maak daarom enkele 
kopieën van de shape, 

die begrenzing van het gebied is en 
zet alle kopieën op een andere laag. 
Zet de zojuist aangemaakte lagen uit, 
zodat de shape bij de delete actie niet 
verwijderd wordt. Deze shapes hebben 
we op een later tijdstip nog nodig.

Knip het betreffende gebied af via 
Fence from Element > Void Clip.

Mesh

Je hebt nu een puntenwolk van het 
gebied, waarvan het grondverzet bere-
kend moet worden. Van deze punten-
wolk gaan we een mesh maken. Een 
mesh surface is het gemiddelde van een 
ware surface en is opgebouwd uit drie-
hoekige polygonen. Het berekenen van 
een volume van een ware surface kost 
erg veel rekenkracht en tijd. Een mesh 
verdeelt de complexe geometrie in 
verschillende simpele polygonen, waar-
door er geen problemen ontstaan bij het 
berekenen van een mesh volume. De 
Mesh Modeling commando’s zijn terug 
te vinden in de Mesh Modeling Task.

Maak van de puntenwolk een mesh 
met het commando Create Mesh 
from Points en zorg ervoor dat de 
optie Expand to Rectangle aanstaat. 
Expand to Rectangle is noodzakelijk, 
anders wordt de ondergrond niet vlak. 
Een vlakke ondergrond is noodza-
kelijk voor de volumeberekening.

 

Bepaling van het grondverzet via Mesh Modeling commando’s



11

Mesh modeling commando’s in de praktijk
Tekst: Mark Stals, gemeente Eindhoven

Als de mesh (of DTM: Digitaal Terrein 
Model) gegenereerd is, kun je via het 
commando Mesh Audit het uiterste 
hoogste en laagste punt uitlezen.

Knip de mesh van het betreffende 
gebied af via Fence from Element > 
Void Clip. Gebruik hiervoor één van de 
bovengenoemde shapes. Het resultaat 
is een mesh van het grondverzetgebied.

Zet één van de eerder aangemaakte 
shapes aan en verplaats deze shape 
naar de nieuwe maaiveldhoogte. Zo 
kun je zien of het nieuwe maaiveld de 
mesh wel of niet doorsnijdt. Indien 
de nieuwe maaiveldhoogte de huidige 

situatie niet doorsnijdt, dan kun je 
de volgende stappen aan houden. 

Gebruik het commando Create Base 
om de mesh te ‘extruderen’ naar 
de nieuwe maaiveldhoogte. 

Hiermee creëer je een mesh met 
een volume. Dit volume kan ver-
volgens via het commando Au-
dit Mesh uitgelezen worden.
Indien de nieuwe maaiveldhoogte de 
huidige situatie doorsnijdt, dan moet 
zowel alles wat boven het maaiveld uit-
steekt, als alles wat onder het maaiveld 
uitsteekt, apart berekend worden. Hier-
voor moeten we de mesh doorsnijden. 

Doorsnijden kan met het commando 
Mesh Substract. Zet de optie Keep 
Originals op All. Als je eerst de shape 
van de Mesh aftrekt, blijft het buiten-
werk over. Als je de Mesh van de shape 
aftrekt dan blijft het binnenwerk over.

Via Close Mesh to Volume kun je van 
de mesh een volume maken die met 

Audit Mesh kan worden getoond.
 

Het kan voorkomen dat het volume 
niet berekend kan worden vanwege 
Voids of Inconsistent Normals, (foutjes 
in de mesh). Met de commando’s 
Cleanup Mesh en Change Mesh 
Normal kun je de mesh opschonen. 

CONCLUSIE

Het handmatig bepalen van het grondver-

zet is voor de civieltechnisch ontwerper 

een tijdrovend karwei. Door gebruik te 

maken van de Mesh Modeling com-

mando’s is het mogelijk om het volume 

nauwkeurig te berekenen en kan er 

een grote tijdwinst behaald worden. 
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Gecontroleerd meerdere tekeningen, of delen ervan, in één keer printen

Tips en Trucs: Print Organizer in MicroStation V8i

Print Organizer is de opvolger van Batch Print en 
heeft in principe hetzelfde doel. In één printopdracht 
meerdere tekeningen, of delen ervan, afdrukken op 
een printer of naar één of meerdere PDF-bestanden. 
Conceptueel verschilt de Print Organizer echter flink 
van de ‘oude’ Batch Print. Reden om eens te kijken 
welke nieuwe mogelijkheden er nu zijn.

HOE WERKT DE PRINT ORGANIZER
Door globaal de stappen te doorlopen, die nodig zijn 
om een Print Set aan te maken en die vervolgens te 
printen, worden de mogelijkheden van de Print Organi-
zer vanzelf duidelijk. Gebruikers die tot nu toe gebruik 
maakten van Batch Print, zullen de verschillen opmer-
ken en hoogstwaarschijnlijk blij zijn met de nieuwe 
mogelijkheden. De .job-files van Batch Print kunnen 
overigens worden ingelezen in Print Organizer en als 
het echt moet is het nog mogelijk om via de Key-in 
“mdl load batchplt” Batch Print op te roepen, al wordt 
dit niet meer officieel ondersteund door Bentley. 

Via de menuoptie File>Print Organizer verschijnt een 
dialoogbox op het scherm met een lege Print Set. Het 
is uiteraard mogelijk om een bestaande Print Set te 
openen, maar we gaan nu een nieuwe maken. Via de 
menuoptie File>Add Files to Set (in de Print Organizer 
dialoogbox) kunnen tekeningen worden toegevoegd. 
Dit kan overigens ook door in de Windows Verkenner 
tekeningen te selecteren en naar de Print Organizer 
dialoogbox te slepen.

PRINT DEFINITION
Van iedere tekening, die aan de Print Set wordt toe-
gevoegd, wordt een Print Definition aangemaakt. Een 
Print Definition is een verzameling van eigenschappen, 
die de weergave van één te printen pagina bepaalt. Dit 
omvat onder andere de naam van de designfile, naam 
van het model, printgebied (de grenzen van een view 
of saved view, een fence of een Sheet definitie), papier-
formaat, printschaal, pentabel, kleurkeuze, print display 
attributes en nog veel meer. In grote lijnen komt dit 
overeen met de instellingen, die je kan doen als je een 
enkele print maakt vanuit MicroStation.

Print Organizer dialoogbox (printorganizer.png)
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Tips en Trucs: Print Organizer in MicroStation V8i
Tekst: Richard Zethof, cad2reality

Toevoegen van tekeningen 
aan Print Set Tablad Main van Print 

Definition eigenschappen

Tablad Advanced van Print 
Definition eigenschappen

Tablad Fence van Print Definition 
eigenschappen. Hier wordt het 
te printen gebied vastgelegd.

Tablad Display van Print Definition 
eigenschappen. Hier worden de 
print display attributes ingesteld.

Hoewel je veel instellingen achteraf kunt wijzigen, is het 
wel handig om de eigenschappen van de Print Definition 
goed in te stellen voordat je een grote hoeveelheid teke-
ningen toevoegt. 

Dit kan op een aantal manieren. Je kan bijvoorbeeld één 
of meerdere Print Styles aanmaken via de menu-optie 
Tools>Define Print Styles. Als je deze Print Styles aanmaakt 
in een dgnlib zijn zij meteen voor alle gebruikers beschik-
baar. Bij het toevoegen van tekeningen aan de Print Set 
kan vervolgens een Print Style gekozen worden. Het is ook 
mogelijk om bij het toevoegen van tekeningen te kiezen 
voor Manually Specified Options.
Zoals eerder gezegd is het mogelijk om instellingen achter-
af te wijzigen. Dit kan uiteraard ook weer op verschillende 
manieren. Als al een Print Style aanwezig is, die je wilt ge-
bruiken, kan je één of meerdere Print Definitions selecteren 
en kiezen voor de menuoptie Tools>Apply Print Style. Eén 
enkele eigenschap veranderen gaat het snelste door eerst 
de gewenste Print Definition(s) te selecteren en vervolgens 
op de te wijzigen eigenschap te dubbelklikken. Zo kan je 
bijvoorbeeld snel het papierformaat veranderen. Er ver-
schijnt dan een keuzelijst. Wil je meerdere eigenschappen 
veranderen, selecteer dan de gewenste Print Definition(s), 
druk op de rechtermuisknop en kies voor Properties.

STRUCTUREREN
Binnen een Print Set is het mogelijk om structuur aan te 
brengen door folders aan te maken, waarin Print Defini-
tions opgeslagen kunnen worden. Zo kan bijvoorbeeld 
onderscheid gemaakt worden tussen verschillende vakdis-
ciplines. In het geval van verschillende vakdisciplines kan 
het zijn dat de tekeningen met verschillende Workspaces 
zijn aangemaakt. Het is mogelijk om in Print Organizer een 
Workspace te kiezen (zowel op User- als op Projectniveau), 
zodat de plots correct worden aangemaakt (denk hierbij 
aan gebruikte lijnstijlen e.d.). 

Structureren kan ook door de standaard benaming van 
de Plot Definitions en Output File Names aan te passen. 
Het handigste is om hierover van tevoren na te denken en 
instellingen te doen via de menuopties File>Default Print 
Definition Name en File>Output File Names. De Output 
File Names worden gebruikt als voor iedere Print Defini-
tion een separaat plot- of PDF-bestand gemaakt wordt. 
Het is mogelijk om deze vlak voor het printen nog  
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Bekijk een preview van één, meerdere, of 
alle Print Definitions (preview.png)

aan te passen. De Default Print Definition Names 
worden ook gebruikt als bladwijzer als alles naar 
één PDF-bestand geprint wordt. Het is dus wel be-
langrijk om deze goed in te stellen. Achteraf wij-
zigen gaat iets lastiger. De folderstructuur wordt 
overigens ook opgenomen in de bladwijzers wan-
neer alles naar één PDF-bestand geprint wordt.

BEKIJKEN EN PRINTEN
Voordat daadwerkelijk geprint wordt kan een pre-
view bekeken worden van één, meerdere, of alle Print 
Definitions via File>Print Preview. Daarna wordt het 
eindelijk tijd om op de printknop te drukken. Uiter-
aard kan ook nu nog het één en ander ingesteld 
worden. Zo kan je een Printerdriver kiezen. Dit zijn 
gewoon de standaard MicroStation Printerdrivers. 
Valt de keuze op printer.pltcfg dan kan je vervol-
gens kiezen welke Windows printer gewenst is.

Het is mogelijk om alle Print Definitions in de Print Set 
te printen of een selectie. Ook kan het aantal kopieën 
ingesteld worden (bij Windows printers en de HPGL/2 
driver). Bij Submit as kan gekozen worden tussen Single 
print job of Separate print jobs, waarbij bij de laatste 
keuze de Output File Names weer van belang zijn. 

PRINT ORGANIZER KEY-INS
Via Key-ins is het mogelijk om de Print Organizer te 
starten, een Print Set te maken, tekeningen toe te 
voegen, aanpassingen te doen en uiteindelijk de print(s) 
te maken. Key-ins kunnen gebruikt worden in BASIC-
macro’s, MDL-applicaties of gewoon in het Key-in 
window. Als je een serie Key-ins opslaat in een tekstbe-

stand kunnen deze in één keer gestart worden vanuit 
het Key-in window. Sla bijvoorbeeld de onderstaande 
Key-ins op in het tekstbestand c:\plotting\plots.txt

  mdl load bentley.microstation.printorganizer.dll
  printorganizer new
  printorganizer printerdriver pdf.pltcfg
  printorganizer add file c:\tekeningen\tekening1.dgn
  printorganizer add file c:\tekeningen\tekening2.dgn
  printorganizer add file c:\tekeningen\tekening3.dgn
  printorganizer submitas single
  printorganizer print all
  printorganizer exit

Vervolgens toets je in het Key-in window het volgende 
in: @c:\plotting\plots.txt. Bij regelmatig gebruik van de 
Print Organizer kunnen Key-ins het werk vereenvoudigen 
en versnellen. 

CONCLUSIE

Misschien lijkt het een ingewikkeld verhaal, maar niets is minder 

waar als je een beetje vertrouwd bent geraakt met de Print 

Organizer. Dan zul je zien dat er nog veel meer mogelijk is. Een 

zeer nuttige toevoeging in MicroStation dus. Meer informatie 

kan je vinden bij de Help-functie in het hoofdstuk Working With 

Complete Designs.
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Interessante opties in MicroStation V8i SELECTseries 2

Een Early Access Preview van MicroSta-

tion V8i (SELECTseries 2) is beschikbaar. 

Op de SELECT website van Bentley kan 

Beta1 van MicroStation V8i (SELECT-

series 2) gedownload worden. Deze 

versie kan gewoon naast een aanwe-

zige versie van MicroStation geïnstal-

leerd worden om zonder nevenef-

fecten te testen. Zijn er weer nieuwe 

interessante mogelijkheden? Zeker!

Naast het oplossen van (schoonheids)foutjes 
zijn ondermeer de volgende ontwikkelingen 
te testen:
•  Clash Detection
•  Autodesk® RealDWG™ 

2010 ondersteuning
•  Ondersteuning Autodesk FBX-bestanden
•  DGN Desktop Text Search
•   Uitbreidingen op gebied van 

Geographic Coordinate Systems
•  Ondersteuning Point Clouds
•  Schedule Simulation uitbreidingen
•   Veel verbeteringen en uitbreidin-

gen op gebied van visualisatie

Clash Detection

Met Clash Detection is het mogelijk om 
sets van (grafische) gegevens te identifi-
ceren en te controleren of er geometrische 
clashes (botsingen) zijn tussen deze sets 
van objecten. Dit kan allemaal grafisch en 
interactief geanalyseerd worden. Op basis 
van in te stellen regels kunnen bepaalde 
clashes wel of niet gerapporteerd worden. 
In een clash job worden alle criteria, regels 
en resultaten opgeslagen. Dit gebeurt in 
de actieve DGN-file of in een DGNLIB.

Autodesk® RealDWG™ 2010 ondersteuning

Het bestandsformaat van AutoCAD R2010 
wordt standaard ondersteund in MicroSta-
tion V8i (SELECTseries 2). Omdat deze 
versie nog niet commercieel beschikbaar 
is, heeft Bentley hiervoor ook een sepa-
rate update vrijgegeven. Je hebt dan wel 
minimaal een V8i SELECTseries één 
product (zoals MicroStation) nodig.

Een object enabler is een programma dat no-
dig is om speciale objecten in een DWG-be-
stand te interpreteren. Als een object enabler 
vereist is, maar niet aanwezig, is het mogelijk 
dat bepaalde geometrie niet correct getoond 
wordt. Vanaf V8i (SELECTseries 1) kan 
MicroStation direct object enablers draaien 
die ook werken in AutoCAD. Hierdoor zal 
de presentatie van grafische objecten correct 
zijn. Als een object enabler nodig is, maar 
niet aanwezig, zal dit kenbaar gemaakt wor-
den aan de gebruiker en in sommige gevallen 
zelfs met de vermelding waarvandaan deze 
gedownload kan worden. De tekening zal 
overigens wel altijd openen waarbij speciale 
objecten als proxy object gezien worden.

Door de ondersteuning van RealDWG 
ontstaat een hogere betrouwbaarheid bij het 
werken met DWG-bestanden in MicroSta-
tion. Daarnaast worden DWG-bestanden, 
die in MicroStation gemaakt zijn, nu door 
AutoCAD als ‘trusted’ gezien. Ook is het 
handig dat AutoCAD’s standaard SHX-
fonts nu gewoon beschikbaar zijn.

Autodesk FBX-bestanden

FBX is een uitwisselingsformaat van Au-
todesk en bedoeld om 3D-informatie uit te 

wisselen tussen verschillende producten.

Point Clouds

In deze versie van MicroStation kan met 
Point Clouds gewerkt worden. Meer infor-
matie hierover is te lezen in het verslag van 
de BE Communities LIVE Conference.

Visualisatie

Sinds de integratie van de Luxology Ren-
dering Engine gebeurt er bij iedere nieuwe 
update weer veel. Dit keer kunnen onder-
meer de volgende ontwikkelingen bekeken 
en getest worden: Meer render output, wat 
ondermeer zeer interessante postprocessing 
mogelijkheden geeft - Material Editor dialog 
is uitgebreid maar toch overzichtelijker 
geworden door een indelingen in tabs - Light 
Manager dialog heeft nieuwe mogelijkheden 
en ook een indeling in tabs - Environments 
Settings dialog - Luxology Image Settings 
dialog - Luxology Render dialog. Naast 
nieuwe opties is het nu ook mogelijk om 
images van tenminste 10.000 x 10.000 pixels 
te renderen - Animator improvements. 
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Het tijdperk van de ‘digitale’ structuurvisie
Gemeenten zijn onder de Wro (Wet ruimtelijke orde-
ning) verplicht één of meerdere structuurvisies op te 
stellen voor het gehele gemeentelijke grondgebied. 
Aan deze verplichting is echter geen sanctie gekop-
peld. De koppeling van de structuurvisie aan de GREX 
(Grondexploitatiewet) is voor de gemeenten toch vaak 
het argument om een structuurvisie te maken. Met het 
maken van een digitale (objectgerichte) structuurvisie is 
in het werkveld echter nog niet veel ervaring opgedaan. 

In de structuurvisie worden op een hoger schaalniveau 
uitspraken gedaan over de gewenste ruimtelijke ontwik-
keling van een gebied. Voor het gemeentebestuur is de 
structuurvisie een belangrijk kader voor de afweging 
van concrete ruimtelijke beslissingen en voor de inzet 
van bestuurlijke uitvoeringsinstrumenten (bestem-
mingsplannen, projectbesluiten, overeenkomsten). 
Daarnaast bevat de structuurvisie uitspraken over de 
realisering van de voorgenomen ontwikkelingen.

Opbouw

RDH (Rothuizen van Doorn ’t Hooft) gebruikt bij de 
totstandkoming van een structuurvisie de zogenaamde 
lagenbenadering als basis voor de ruimtelijke analyse 
van het structuurvisiegebied. Vanuit deze analyse wordt 
een Duurzaam Ruimtelijk Structuurbeeld opgesteld, 
waarin de belangrijkste ruimtelijke structuren van het 
structuurvisiegebied (los van toekomstig programma) 
worden vastgelegd. Door maatschappelijke ontwikkelin-
gen te spiegelen aan het ruimtelijk structuurbeeld worden 
de contouren van de visie duidelijk. Op basis van deze 
visie kan aan een strategie gewerkt worden, die ingaat 
op de wijze waarop de visie verwezenlijkt kan worden. 
In deze strategie wordt – zo veel mogelijk gebiedsge-
richt - het beleid bepaald dat leidt tot de realisatie van 
de gewenste visie op de einddatum van het plan.
 
Digitale raadpleegbaarheid

Bij de verplichting om een digitaal plan beschik-
baar te stellen kan in principe worden volstaan 
met de verwijzing vanuit de plancontour naar een 
PDF-bestand. Het digitale plan is daarmee een feit. 
Wil men van het plan de inhoud digitaal op een dui-
delijke manier raadpleegbaar maken, dan zal hier 

De digitalisering van de ruimtelijke orde-

ning heeft sinds 1 januari 2010 ook de 

structuurvisie in zijn greep. Eerst waren 

het de bestemmingsplannen die, in een 

traject van tien jaar, beetje bij beetje 

gestandaardiseerd en objectgericht zijn 

gemaakt. Nu is het de beurt aan de (ge-

meentelijke) structuurvisie. Hierin worden 

onder andere keuzes vastgelegd voor de 

ruimtelijke ontwikkeling van een gemeen-

te. Om een toekomstbeeld te realiseren 

wordt aandacht besteed aan bijvoorbeeld 

identiteit, de gewenste omvang van de 

gemeente, het woonmilieu, de werksi-

tuatie, de infrastructuur, de benodigde 

voorzieningen en nog veel meer.
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Het tijdperk van de ‘digitale’ structuurvisie
Tekst:  Perry Zijlema, 
 Rothuizen van Doorn ’t Hooft (RDH)

bij het ontwerp rekening mee gehouden moeten worden. Dit komt tot uiting 
bij het ontwerp van het kaartbeeld en bij de inrichting van de beleidsteksten. 
De vlakken en teksten kennen namelijk een rechtstreekse onderlinge relatie en 
die kan alleen tot stand worden gebracht als het beleid niet is verspreid door 
de gehele tekst. Tegelijkertijd is alleen een objectgerichte tekst onleesbaar.

Structuurvisie Terneuzen als voorbeeld

De structuurvisie Terneuzen 2025 is een voorbeeld van de combinatie van een 
leesbaar analoog boekwerk, dat ook goed digitaal raadpleegbaar is. Voor een leesbaar 
verhaal is het noodzakelijk dat de structuurvisie beschikt over een duidelijke opbouw, 
waarin de lezer aan de hand wordt genomen en door het plan wordt geleid. Dit komt 
in de structuurvisie goed naar voren in de verwoording en de onderbouwing van de 
visie. Voor het digitaal kunnen raadplegen zijn met name de beleidsvoornemens van 
belang. De visie is daartoe concreet vertaald naar gebieden met een bepaalde strate-
gie. Deze zijn gebundeld in de uitwerking van de strategiehoofdstukken (per object 
en complex) en gekoppeld aan de digitale kaart. Daarmee wordt ook niet het eind-
beeld concreet vastgelegd, maar de strategie om het eindbeeld te bereiken. Door van 
te voren te anticiperen op de digitale raadpleegbaarheid, heeft de feitelijke codering 
van het plan niet veel extra tijd gekost. De codering van het plan hielp zelfs de strate-
giekeuzes te structureren. De structuurvisie Terneuzen 2025 is momenteel als ontwerp 
te raadplegen op www.ruimtelijkeplannen.nl en wordt binnenkort vastgesteld. 

Structuurvisiekaart (analoog)

Duurzaam ruimtelijke structuurbeeld (DRS)

Strategiekaart in ruimtelijkeplannen.nl (digitaal)
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Dit artikel gaat in op enkele high-

lights van de nieuwste versie van 

ProjectWise V8i (SS2), die ge-

toond werden op de Bentley User 

Conference van mei 2010.Bentley 

is ondertussen aan versie V8i SS2 

toe (SELECT-Upgrade Series 2). 

Op dit moment is alleen V8i SS1 

beschikbaar, maar binnenkort (vol-

gens belofte nog in juni) is ook SS2 

beschikbaar. En dan volgt er waar-

schijnlijk in december nog een SS3.

De Bentley User Conference had 
het thema ‘BE Together’. Hoewel 
er dit jaar maar weinig Europeanen 
waren (waaronder zes Nederlanders 
en niemand van Bentley Nederland) 
werd de sfeer inderdaad gemaakt door 
‘samen’ en ‘ons kent ons’. De opzet 
van de conferentie was als vanouds, 
maar dan een beetje ‘back to basic’: 
info over de nieuwste versies en pro-
ducten en genoeg mogelijkheden om 
zelf via een korte cursus ‘hands-on’ te 
werken. Uiteraard werd er weer veel 
aandacht besteed aan ProjectWise.

ProjectWise V8i

Ook ProjectWise V8i SS2 heeft weer 
een leuk aantal nieuwe opties. Behalve 
de opties van V8i die al bekend zijn, 
zoals Delta File Transfer (alleen de 
wijzigingen van het document over 
het netwerk sturen), File Compressie 
(anders dan zip) en natuurlijk de intus-
sen beroemde Quick Search (zoeken 
op de Google-manier), heeft SS2 
weer een aantal aanvullingen die erg 
praktisch zijn. Voor mij waren de meest 
in het oog springende nieuwe zaken de 
geïntegreerde Dependancy Manager en 
de Revit integratie. Maar daarover later 
meer. Eerst hieronder een korte opsom-
ming van de belangrijkste nieuwtjes.

I-Models

Eén van de belangrijkste vernieuwin-
gen in deze versie is de ondersteuning 
van i-Models. I-Models is een techniek, 
die met MicroStation V8i SS2 geïntro-
duceerd is en die inhoudt dat uitwisse-
ling tussen systemen (binnen Bentley 
softwaredelen, maar ook met derde 
partij-software) zo soepel mogelijk en 
zonder dataverlies moet plaatsvinden. 
Daarbij hanteert Bentley kreten als 

‘self-describing’ (ingebouwd meta-
datamodel), ‘guaranteed precision’ 
(schijnt soms bij uitwisseling verloren 
te gaan) en ‘provenance to original ap-
plication’ (de file weet met welke soft-
ware deze oorspronkelijk gemaakt is). 
Daarmee is het mogelijk files van soft-
ware als AutoCAD, Revit,PDS/PDMS, 
etc zo goed mogelijk te ondersteunen.

SharePoint 2010

ProjectWise V8i zal SharePoint 2010 
gaan ondersteunen. Of dit al in de 
SS2 versie zal zijn, is nog even de 
vraag, maar zeker in de SS3 versie.

Geo-codering

ProjectWise V8i SS2 biedt de moge-
lijkheid om een willekeurig bestand 
een geocodering mee te geven en 
biedt bovendien de mogelijkheid om 
de interne geoinformatie op basis van 
XFM-info in het document te gebrui-
ken voor indexeren of zelfs zoeken.

Worksharing support

Dit is een nieuwe techniek, die het 
mogelijk moet maken gedeelde 
bestanden vanuit ProjectWise te 
beheren. Voor Revit is dit al uitge-
werkt, maar de techniek is ook op 
andere applicaties met gedeelde 
bestanden van toepassing.

Change Alert

ProjectWise kent al een methode 
van waarschuwing bij gewijzigde 
status van het document (e-mail 
event-trigger), maar deze is/
wordt uitgebreid naar andere mel-
dingsystemen en beknopte DMs-
handelingen. Zoals automatisch 
beveiligen, automatisch plotten/
renderen etc, wanneer het document 

Een terugblik op het ProjectWise nieuws uit Philadelphia

ProjectWise volop in beweging
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Tekst: Johan Vreede, Studio 4D

aan bepaalde voorwaarden voldoet.
Custom Audit Trail

Hiermee samenhangend is er de mogelijkheid om te bepalen 
welke acties wel of niet in de audit-trail worden bewaard 
(het historiebestand kan namelijk nogal flink groeien).

Workspace Support & Standards Management

Voor de ondersteuning en het beheer van eigen werkomgevin-
gen, en controle en bewaking van de inhoud van die werkom-
geving, heeft versie SS2 extra mogelijkheden gekregen. Hier-
door kan het beheer zich uitstrekken tot Content Management.

Dependency Manager

En dan de echt leuke zaken. Allereerst Dependency Manager. 
Deze plug-in voor ProjectWise V8i, die bij SS2 beschikbaar 
komt, zorgt ervoor dat relaties tussen documenten (en zelfs ook 
de links naar infodelen buiten de documenten, zoals LinkSets) 
grafisch, dat wil zeggen in schemavorm, weergegeven worden. 
Daarbij kan de aard van de relatie (“is van invloed op de refe-
rentie” of “referentie heeft invloed op”) in kleur weergegeven 
worden, en kunnen ook speciale filters toegepast worden (nest-
diepte, typen objecten zoals models linksets etc). Daarnaast 
kan Impact analyse toegepast worden (“wat gebeurt er met de 
relaties als deze ref…”), waarbij het mogelijk is elk document 
in de set van files tot ‘root’ (topdocument) te promoten.

Worksharing for Revit

ProjectWise V8i SS2 ondersteunt Revit (2009, 2010 en later 
ook 2011) nagenoeg volledig. Dat betekent dat de techniek van 
een gedeeld hoofdbestand (‘BIM-database’) voor deze applica-
tie volledig beschikbaar is, en dat ook application-file-support 
vanuit ProjectWise uitgewerkt is (templates in ProjectWise 
ophalen of Families laden vanuit ProjectWise). Daarbij wordt 
gebruik gemaakt van een local centraal bestand, waarin de 
wijzigingen van alle deelnemers in de gedeelde database ver-
zameld worden. Dit bestand kan via opties als ‘post changes’ 
en ‘reload latest’ automatisch of op verzoek gesynchroniseerd 
worden met het centrale bestand in ProjectWise. (Overigens 
is onderhoekintegratie voor Revit nog niet uitgewerkt).

Er is dus weer meer dan genoeg aanleiding om een upgrade 
naar de nieuwste versie van ProjectWise te overwegen. En...
voor meer informatie kunt u altijd terecht bij de TMC Focus-
groep ProjectWise.  

ProjectWise volop in beweging
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Tijdens een gesprek met drie 

specialisten op het gebied van 

geo-informatie, die allemaal 

een andere achtergrond heb-

ben, worden krasse uitspraken 

gedaan.Volgens hen valt er veel 

te verbeteren op het gebied van 

geo-informatie! Wordt er nu echt 

zo slecht samengewerkt? Wordt 

er in voortrajecten nu echt te 

weinig nagedacht? Of valt het 

allemaal wel mee? Hun kritische 

opmerkingen komen natuurlijk 

niet zomaar uit de lucht vallen.

Jochem Mollema is al meer dan 
veertien jaar werkzaam in het vak 
van geo-ict. Ooit is hij begonnen met 
GEOCAD (toen nog een oplossing van 
Bowhouse) en via Falkplan, Bentley 
en Urbidata uiteindelijk zelfstandig 
adviseur geworden en eigenaar van 
Unafact. Momenteel houdt hij zich 
bezig met het oplossen van (geo)
ICT vraagstukken, organisatieadvies, 
projectmanagement en integratie van 
gegevens en omgevingen. Dolf de 
Rooij is werkzaam bij de gemeente 
Amstelveen als teamleider Geo-
informatie. Hij heeft een bedrijfs-
kundige achtergrond, waarvan hij bij 

zijn huidige taak veel gebruik maakt. 
Hij is voorzitter van de TMC Geo 
Focusgroep en sinds dit jaar is hij 
bestuurslid van het TMC hoofdbestuur. 
Guido Lammers is werkzaam bij 
Stadsdeel Slotervaart (vanaf mei 2010 
opgegaan in Stadsdeel Nieuw-West) 
van de gemeente Amsterdam als GIS-
adviseur, maar houdt zich ook bezig 
met (stedenbouwkundig) tekenwerk 
en applicatiebeheer. Hij maakt tevens 
deel uit van de TMC Geo Focusgroep.
Bij elkaar dus voldoende kennis 
aanwezig om eens inhoudelijk en 
objectief in te gaan op verschil-
lende aspecten van geo-informatie.

Waar staan we nu?

Op gebied van geo-informatie is de 
laatste tien jaar veel gebeurd. We zijn 
in staat om mooie kaartjes te maken, 
maar die bereiken niet altijd hun doel. 
Vanuit de centrale overheid worden 
basisregistraties opgelegd, zoals de 
Basisregistratie Adressen en Gebou-
wen (BAG). Die zijn heel belangrijk, 
maar leggen wel een flinke druk op de 
organisatie. In positieve zin leidt dit tot 
een betere (gedwongen) samenwerking, 
wat door de heren als zeer belangrijk 
wordt gezien bij het succesvol kun-
nen gebruiken van geo-informatie. 

Volgens Dolf is de uitwerking van de 
BAG wel matig. “In het voortraject 
wordt nog wel eens te weinig nage-
dacht”, vertelt hij. “Verder komt het 
geo-werkveld vaak pas als laatste op 
de proppen bij het ontwikkelen van een 
oplossing, terwijl zij er misschien wel 
als eerste bij betrokken zou moeten 
zijn. Bij de BAG zie je overigens dat 
het van origine opgericht is vanuit een 
administratieve invalshoek.” Guido 
voegt hier aan toe dat de term ‘geo’ 
binnen de gemeente vaak geassocieerd 
wordt met techneuten en daardoor mis-
schien niet de juiste aandacht krijgt.

Objectgericht werken

Volgens Jochem zijn er nu nog veel 
beperkingen, omdat er nog niet veel 
objectgericht gewerkt wordt. Geo-in-
formatie volstaat in deze tijd niet meer 
met punt (x,y) informatie. Het gaat om 
het object waarbij de geometrie en de 
administratieve informatie onlosma-
kelijk met elkaar verbonden zijn. Het 
object wordt steeds belangrijker. Neem 
bijvoorbeeld een aardgastank op een 
terrein. Informatie hiervan moet niet al-
leen aan de hoofdadres gekoppeld zijn, 
maar ook aan de werkelijke locatie, de 
geometrie, zelf. Uiteraard kan dit wel 
complex worden. Bij de BAG gaat het 

Wordt Geo-informatie wel optimaal ingezet om organisatiedoelen te bereiken? Of valt er nog veel te verbeteren?

Geo-informatie doel of middel?

Op de foto’s boven: Chinese objecten en wegwerkzaamheden in de openbare ruimte van Den Haag.
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Wordt Geo-informatie wel optimaal ingezet om organisatiedoelen te bereiken? Of valt er nog veel te verbeteren?

Geo-informatie doel of middel?

Tekst: Richard Zethof, cad2reality

om een handjevol objecttypes, terwijl er 
in de openbare ruimte van een gemeente 
er honderden objecttypes voorkomen! 
Er zijn dus nog veel objectgerichte 
toepassingen mogelijk. Door de invoe-
ring van de BAG en andere registraties 
werken gemeenten, zonder dat ze dit 
zich goed beseffen, al objectgericht.

Vaak weet men zelf niet eens goed 
wat allemaal beheerd wordt. Als er 
eenvoudige vragen gesteld worden over 
hoeveel lichtmasten of prullenbakken 
er beheerd worden, of misschien wel 
hoeveel m² paden er op de begraaf-
plaatsen zijn (handig om te weten voor 
het uitbesteden van onderhoud), weet 
men vaak het antwoord niet direct.

Leveranciers

Momenteel is er al veel gereedschap 
voorhanden. Bentley is één van de leve-
ranciers hiervan. De heren benadrukken 
dat de rol van Bentley vooral ligt bij het 
leveren van een basis. Bentley beschikt 
met MicroStation en Bentley Map over 
de gereedschappen om objectgericht 
te werken. Uiteindelijk zijn lokale 
partners belangrijk voor de gewenste 
toegevoegde waarde. Jochem vindt wel 
dat de Geo-leveranciers de weg moet 
openzetten naar objectgericht werken, 

iets dat nu nog te weinig gedaan wordt. 
Wat verder als ‘probleem’ gezien wordt 
is het lifecycle management. Vaak is 
er nog teveel onderscheid tussen tools 
voor het ontwerpproces en voor het 
beheer. Daarnaast moeten leveranciers 
zich bewust zijn van standaardisatie. 
Daar ontbreekt het namelijk nogal 
eens aan. Gebruik je bijvoorbeeld de 
term ‘lantaarnpaal’ of ‘lichtmast’? 
Het is belangrijk dat leveranciers hun 
oplossingen configureerbaar maken en 
daarnaast ook nog eens schaalbaar.

Geo-informatie doel of middel?

De algemene conclusie is dat in de 
praktijk in veel gevallen geo-informatie, 
bewust of onbewust, als doel op zich 
wordt gezien en hierdoor mogelijk niet 
op de juiste waarde ingeschat. Vaak is 
deze informatie juist nodig om goede 
beslissingen te kunnen nemen voor een 
betere bedrijfsvoering en moet dus als 
middel gezien worden. Informatiemana-
gers spelen hierbij een belangrijke rol. 
Zij krijgen een steeds grotere stem in 
het geheel, maar zij missen nu vaak nog 
de kennis. Kort samengevat worden de 
volgende overwegingen meegegeven:

•  Informatiemanagers moeten meer 
kennis krijgen van geo-informatie en 
het belang hiervan, bij het bereiken 
van de doelen van de organisatie.

•  Een betere samenwerking is nood-
zakelijk. Nu werkt iedereen nog 
weleens alleen aan eigen oplossingen. 
Dit bevordert het draagvlak niet.

•  Integrale samenwerking bin-
nen een organisatie zou mooi 
zijn, maar integrale architec-
tuur is eigenlijk een ‘must’.

•  De uitdaging ligt dus voorname-
lijk in de interne organisatie. De 

oplossingen zijn er vaak wel!
•  Objectgericht werken bete-

kent efficiënter werken.
•  Maak gebruik van specialisten! 

Bijvoorbeeld specialisten die 
goede data-modelleerders zijn.

•  Maak duidelijk wie eigenaar en wie 
beheerder van informatie is. De 
afdeling geo-informatie is vaak niet 
de eigenaar, maar wel de beheerder.

•  Geo-informatie is de motor voor de 
integratie binnen de organisatie.

•  De data zelf (en dus de kwaliteit 
ervan) is belangrijker dan een tool 
voor de ontsluiting (inmiddels zijn 
daar al genoeg tools voor aanwezig).

De Geo Focusgoep van TMC Neder-
land zou zelf initiatief kunnen nemen en 
de volgende bijeenkomst eens kunnen 
richten op informatiemanagers, met 
als doel om geo-informatie beter op de 
kaart te krijgen binnen organisaties. Wie 
weet op het TMC Forum in oktober? 

Bron: NORA-katern Strategie, ICTU
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Ton de Vries Solutions Executive Government

Uw mening telt...

Na bijna 20 jaar in de Nederlandse Bentley wereld te hebben rondgelopen, 
zit ik nu letterlijk en figuurlijk aan de andere kant. Letterlijk, want ik ben in 2008 
verhuisd naar Exton, Pennsylvania, en figuurlijk want ik ben nu werkzaam bij de 
softwareontwikkelafdeling (BSW – Bentley Software) van Bentley. Daar wil ik het 
graag in deze column over hebben. Hoe Bentley tot keuzes komt in softwareont-
wikkeling en hoe u daar invloed op kunt uitoefenen.

U ziet het, ik zit niet meer in sales, dus ik ga via deze column u niet proberen en-
thousiast te maken voor bijvoorbeeld onze recente 3D City GIS-ontwikkelingen, 
de nieuwe Silverlight client voor Geo Web Publisher of de FME support voor 
Bentley Map. Nee, ik ga schrijven over de noodzaak voor softwareontwikke-
laars om veel informatie van klanten te krijgen. Alleen als wij van u horen welke 
nieuwe functionaliteit of werkwijze wij in de toekomst moeten ondersteunen, 
dan kunnen wij daarop inspelen en de functionaliteit tijdig ontwikkelen. Nu zult 
u denken: tja maar dat doen we al, we hebben regelmatig contact met onze 
Account Manager, er komen consultants van Bentley over de vloer en ‘ze weten 
toch wat we graag willen’.

U raadt het al, het antwoord is ‘nee, vaak niet’. De beste informatie is ongefilter-
de informatie. Rechtstreeks van de gebruiker (dat bent u) naar de ontwikkelaar 
(dat zijn wij). Via SELECTSupport kunt u voorstellen voor wijzigingen –Change 
Requests- indienen. Als u dat op die wijze doet, komt dit rechtstreeks bij de 
Product Managers binnen. Die klassificeren de Change Request onder andere 
op basis van het aantal gelijksoortige aanvragen. Als er meer organisaties zijn 
met eenzelfde verzoek, is de kans groter dat de ontwikkeling op de lijst voor de 
volgende (SELECT Series) release komt te staan. 

En ja, we zien die Change Requests graag in het Engels, maar daar kan uw con-
tactpersoon bij Bentley u weer uitstekend bij assisteren. En zo kunnen we elkaar 
helpen om u uiteindelijk nog beter van dienst te zijn met producten die functio-
naliteit bevatten die u nodig heeft voor uw dagelijkse werk. Want tenslotte doen 
we het daarvoor; software ontwikkelen die u graag gebruikt.

En mocht u een keer in de buurt van Exton, bij Philadelphia, komen, aarzel niet 
om contact met mij op te nemen. Wij vinden het bijzonder leuk als er gebruikers 
in Exton langskomen om te vertellen wat zij met Bentley producten doen en hoe 
wij u nog beter kunnen ondersteunen. En persoonlijk vind ik het dan weer gezel-
lig om een ouderwets Nederlands onderonsje te hebben.

Take care!

ton.devries@bentley.com
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RoTotaal
RoTotaal is een integrale oplossing die het totale ruimtelijke ordening 
proces stuurt en ondersteunt. 

RoCreëer
Een krachtige ontwikkeltool voor digitale ruimtelijke plannen die bestaat uit
de applicaties RoPlan en RoTekst. Alle ruimtelijke plannen kunnen hiermee
worden vervaardigd, gewijzigd en afgerond conform de verplichte landelijke
standaarden.

RoBeheer
De webgebaseerde oplossing voor het digitaal beheer van de ruimtelijke
plannen en bijbehorende processen. RoBeheer ondersteunt de gemeente bij
alle digitale verplichtingen: valideren, waarmerken en beschikbaarstelling
aan RO-Online. Aanvullende functionaliteit is overzicht op de gehele plan-
voorraad en de mogelijkheid de procedures te monitoren en sturen.

Spatial-WMS module
Additionele module bij RoBeheer op basis van Open GIS standaarden.
Verbetert de presentatie in RoBeheer. Tevens kaartverbeelding via WMS 
(Web Map Service), voor een bestaand in- of extern publicatiesysteem.

RoPubliceer
Directe controle over publicatie van ruimtelijke plannen, inclusief inspraak
en/of zienswijzen. RoPubliceer werkt, op basis van Open GIS standaarden, 
direct samen met RoBeheer en de Spatial-WMS module. Publicatie van 
ruimtelijke plannen zonder conversie of afhankelijkheid van derden. 
Unieke vormgeving naar eigen wens.

Het RoTotaal concept is een samenwerking tussen Bentley Systems en Crotec. 
RoPlan en RoBeheer zijn officieel door Geonovum gecertificeerde applicaties.

RoCreëer

RoBeheer

Spatial WMS-module

RoPubliceer

DURP Mag_210x297_Opmaak 1  09-11-09  09:23  Pagina 1


